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Typographic Conventions 

Text 
 Menu paths and menu items are separated by > (for example, 

File > Open).  
 Command buttons (for example, OK, Cancel) are in bold. 
 Field names are in bold. 
 Information you have to type is in monospace Courier. 
 Key presses are in SMALL CAPS. If you have to press more than 

one key at a time, a plus (+) sign shows this. For example, 
SHIFT+TAB. Rarely would you press both keys at exactly the 
same time - usually, you would press the first key and hold it 
down as you press the second key. 

 "Click" means that you should press the primary mouse button 
(the button used for most operations). For right-handed users, 
this is the left mouse button. 

 "Double-click" means that you should press the primary mouse 
button twice, in quick succession.  

 "Right-click" means that you should press the secondary 
mouse button (the button used for auxiliary operations). For 
right-handed users, this is the right mouse button. 

Graphics 

 
Note: Take particular note of this information - it may be 
of special interest, contain further or related information, 
or provide information that doesn't fit well into the flow of 
the text. 

 

Warning or caution: Take care when performing this 
operation or procedure - if you don't follow the information 
correctly, it may result in damage to people, goods, or 
data; alternatively, the information may be complex or 
only able to be carried out by certain personnel. 

 
Hint or Tip: Information that can make you more efficient 
or save you time. It may contain ideas for shortcuts or 
alternate ways of accomplishing tasks, or discuss 
techniques that aren't immediately obvious.  

Spelling 

We use Australian English throughout this manual, so you will see 
"organisation" not "organization" (most "-ize" words are spelled 
with "-ise"), "colour" not "color", "grey" not "gray", and the like. Our 
authority is the Macquarie Dictionary, 3rd edition. 
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Copyright 

The software described in this document is the property of Fractal 
Technologies Pty Ltd and is furnished under a license agreement. 
The software may be used or copied only in accordance with the 
terms of this agreement. Except as permitted by such license, no 
part of this document may be edited, copied or reproduced without 
the written permission of Fractal Technologies. 

Information in this document is subject to change without notice. 
Fractal Technologies will not accept any liability arising from the 
use of the software or any other software product mentioned in this 
document, nor for any technical or editorial errors or omissions 
made in this document. 

FracSIS is a trademark of Fractal Technologies. 

Other brands and their products are trademarks or registered 
trademarks of their respective holders and should be noted as 
such. Trademarked names are used editorially, to the benefit of 
the trademark owner, with no intent to infringe on the trademark. 
The mention of any other computer software product in this 
document does not imply endorsement of such product by Fractal 
Technologies. 

The FracSIS product includes software developed by the Apache 
Software Foundation (http://www.apache.org). Portions of FracSIS 
were developed in cooperation with the CSIRO Glass Earth 
Project (http://www.glassearth.com). 
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Installation: Introduction 

This document details the installation and licensing of the FracSIS 
5.x product suite and ObjectStore in both stand-alone and 
networked environments. 

The FracSIS products are: Professional, Explorer and Reader. 
 

FracSIS 
Professional 

FracSIS Professional is for consultants creating 
and distributing data to external clients and for 
dedicated data managers. FracSIS Professional 
offers the complete suite of data management and 
visualisation features. 

FracSIS 
Explorer 

FracSIS Explorer is the tool of choice for 
geologists and engineers who need the full 
visualisation and image and data output abilities of 
FracSIS Professional, but do not need to create 
and manage databases. Includes movie creation 
and web export capabilities to allow full access to 
project data. 

FracSIS 
Reader 

FracSIS Reader is the visualisation-only 
environment. Perfect for distributing project 
information to clients, contractors, and 
management, FracSIS Reader allows people to 
view data in an interactive 3D environment. Clients 
can view attributes, use visualisation tools, and 
export data, without modifying the database. 

 
 

Network environment 

FracSIS can be networked across an organisation.  

A sample configuration could include: 

Database server 
 Stores the FracSIS databases, but doesn't run any FracSIS 

products. 

 ObjectStore is installed on it. 

 Must be accessible to all FracSIS users on the network. 

License server/computer 
 Stores the FracSIS license information, but doesn't run any 

FracSIS products. 
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 Must be accessible to all FracSIS users on the network. 

 Can be the same computer as the database server. 

Database management computer 
 Runs the database management functions in FracSIS 

Professional. 

 FracSIS Professional and ObjectStore are installed on it. 

 Must be connected to the database server through the 
network for upload and download of data. 

 Must be connected to the license server/computer through 
the network whenever FracSIS is run; FracSIS checks for 
an available and valid license before and during running. 

FracSIS user (client) computers 
 FracSIS product and ObjectStore are installed on each 

client computer. 

 Must be connected to the database server through the 
network so that the user can access the FracSIS data. 

 Must be connected to the license server/computer through 
the network whenever FracSIS is run; FracSIS checks for 
an available and valid license before and during running. 

For example, 

 

 
 

FracSIS clients 

Any computer that is to be used to run a FracSIS product is 
considered to be a FracSIS client. 
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Both FracSIS 5.1 and Object Store must be installed on each 
FracSIS client computer; you will be prompted to install 
ObjectStore as part of the FracSIS installation.  

 
 

FracSIS database servers 

In a networked environment, some or all of the FracSIS databases 
are located on central servers for shared access between a 
number of FracSIS clients. These central servers are known as the 
FracSIS database servers. 

A FracSIS database server only stores the FracSIS database files 
and the ObjectStore Database Server process which controls 
them. ObjectStore controls all access to the FracSIS databases 
located on its host computer, providing consistency and data 
integrity within those databases. ObjectStore must be installed on 
the FracSIS database server.  

To only install ObjectStore on the database server: 

1 Navigate to the ObjectStore folder on the FracSIS 5.x 
Installation CD. 

2 Run setup.exe.  

3 Follow the steps under Installing ObjectStore (page 13). 
  

 
While the FracSIS product software can be installed on 
this computer, it is optional; typically, a networked 
organisation would not install the software on the same 
computer as the central database files. 

  

 
We recommend that your Database Administrator reads 
the Managing FracSIS Databases document (available 
from the Doco\White Papers subfolder of your FracSIS 
5.x Installation CD). This document contains important 
information for correctly managing FracSIS databases 
and using ObjectStore utilities.  

 
 

Stand-alone environment 

FracSIS can be installed on a single computer separate from any 
network; for example, for consultants, or those trialling the 
software. 

 FracSIS product, ObjectStore, and the FracSIS database are 
all installed on the computer. 
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 License checking is based on the HostID of the computer, so 
FracSIS will only work on that computer. 

For example, 
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Prerequisites 

System requirements for FracSIS 5.x 

For any computer running FracSIS (other than those that are used 
only for database file storage (page 11) or to manage database 
(page 11) functions such as importing), the following base system 
requirements must be met. 
 

Item Minimal Optimal 

Computer 
(CPU) 

Pentium IV with 1.7 
GHz+ 

Pentium IV+ with 3 GHz+ 

Memory 512Mb RAM 1Gb+ RAM 

Graphics 
Card** 

3D Graphics Card with 
64Mb+ memory and 
OpenGL 1.3 (or later) 
support 

256Mb+ memory with 
OpenGL 1.5 (or later) 
support 

Operating 
System 

Windows 2000 (with SP1) OR Windows XP (with 
SP2) 

Peripherals CD-ROM, 3-button mouse 
  

 
Graphics Cards 

The OpenGL drivers for graphics cards must be reliable. 
We recommend video cards such as: 
 nVidia GeForce range (FX5950 or higher) 
 ATI range (such as ATI Radeon 9800Pro or higher) 
 other high-quality professional OpenGL cards (such 

as FireGL X1, WildCat, or Quadro FX1100). 
Extra memory enables better image rendering. This is 
particularly important when working with textures, which 
consume a lot of memory. Extra memory also allows for 
higher resolution. 

We strongly recommend these higher-level graphics 
cards as the extra hardware features make light work of 
very large and complex data sets. 
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Prerequisites: FracSIS database server 
 Accessibility: Computers that store FracSIS databases must 

be accessible through the Local Area Network to all FracSIS 
database users. 

 Disk storage and processing ability: Depends on the 
expected volume of data and the amount of traffic from 
FracSIS users. 

 CPU and Memory: Same as the base system requirements 
(page 10). 

 Graphics card: Not applicable if this server is only used to 
store the FracSIS databases; however, if the server is also 
used to run FracSIS products, then the graphics card must be 
the same as the base system requirements. 

Contact Fractal Technologies Technical Support at 
support@fractaltechnologies.com if you have any questions about 
your server requirements. 
 

Prerequisites: FracSIS data management only 

Some sites may choose to run database management functions 
such as importing and exporting from a separate computer to 
prevent overloading the main FracSIS database server. If so, the 
following requirements must be met for this computer: 

 Accessibility: Must be connected through the Local Area 
Network to the FracSIS database storage server. 

 Disk storage: Depends on the expected volume of data; faster 
disk speed and performance are also important. 

 CPU and Memory: At least the same as the base system 
requirements (page 10); importing, exporting and reorganising 
data are memory-intensive operations.  

 Graphics card: Not applicable if this computer is only used to 
manage the FracSIS data; however, if the computer is also 
used to run FracSIS products, then the graphics card must be 
the same as the base system requirements. 

Contact Fractal Technologies Technical Support at 
support@fractaltechnologies.com if you have any questions about 
these requirements. 
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Getting started 

On all computers or servers where FracSIS, ObjectStore, or both 
are to be installed: 

1 Log in to Windows as a user with administrator privileges. 

If you don't know if your login ID has such privileges, contact 
your local system administrator. 

2 Stop and close all Windows applications. 

3 Insert the FracSIS 5.x Installation CD into the CD drive. The 
Installer splash screen is displayed with installation 
instructions. 

You are now ready to begin the installation... 
  

 
Uninstalling previous versions 

If a previous version of a FracSIS product is installed on 
this computer, you will be prompted to uninstall both 
FracSIS and ObjectStore. Follow the Uninstall Wizard 
instructions to uninstall FracSIS then ObjectStore before 
installing the new FracSIS (page 12). 

 
 

Installing FracSIS 

You must install FracSIS on all client computers. In most cases, 
FracSIS is not installed on servers. 

1 Click Install FracSIS on the Installation CD's splash screen. 

2 Select the location where you want FracSIS installed on your 
hard disk.  

We recommend that you use the default location, C:\Fractal 
Technologies\FracSIS5.x (where x is the version number).  

3 Click Next. 
4 Select the FracSIS product to install. Only choose the product 

you have purchased a license for. 

5 Click Next. 
6 Select the FracSIS 5.x Translator components to install.  

There are several Translator (or Importer) plug-in extensions 
that are used to import data from various formats into FracSIS 
5.x. All components are selected by default; we recommend 
that you keep this setting as these components use very little 
disk space.  
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7 Click Next. 
8 Select the Windows Program Manager group under where 

your FracSIS shortcuts will be listed.  

9 Click Next. 
10 Confirm your installation settings. 

11 Click Next. 
The installation starts; all required files for your licensed 
FracSIS product will be installed to the hard disk. 

12 When the installation is complete, click Finish. 

13 You are prompted to install ObjectStore (page 13). 

 
 

Installing ObjectStore 

ObjectStore v6.1sp2 (Version 6.1, Service Pack 2) MUST be 
installed on all computers and servers that will run any FracSIS 
product or store the database files used by FracSIS; it provides the 
underlying database support and FracSIS cannot run without it. 
  

 

DO NOT blindly follow the installation Wizard! There are 
some critical selection options in steps 7 and 16 which, if 
not chosen correctly, will mean that FracSIS will not run. 

1 When the FracSIS installation has finished, you will be 
prompted to install ObjectStore 6.1 service pack 2. 

2 Click Yes to install ObjectStore 6.1. The ObjectStore 
Installation Wizard is displayed. 

3 On the User Information screen of the installation Wizard, type 
the client name in the Name field and the company name in 
the Company field.  

4 Click Next. 
5 In the Destination Folder field, either select the default location 

to install ObjectStore, or browse to locate another drive and 
folder manually.  

6 Click Next. 
7 NOTE: THIS IS IMPORTANT!  

Under the installation options, click Custom. 

8 From the Components list, select the C++ Interface option and 
the ObjectStore DBMS option. 

9 Disable all other options in the Components list.  

10 Click Next. 
11 Click Both client and server.  
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12 Click Next. 
13 Select a program folders directory. We recommend that you 

use the default. 

14 Click Next. 
15 Click Finish when you have made all your selections; the 

installation starts. 

16 During the installation you will be asked some questions: 

Question Response 
Would you like to change the parameters for your 
ObjectStore server? 

No 

Would you like to create RAWFS partitions? No 

NOTE: THIS IS IMPORTANT!  
Initialise ObjectStore server log file? 
(Once you have answered Yes, select the default 
location to store the log file, or browse to locate 
another drive and folder manually.) 

Yes  

Would you like the ObjectStore server to start 
automatically? 

Yes 

Would you like start these services now? Yes 
17 Click Finish. 

18 You are asked to restart the computer. Click Yes to restart. 

The installation of FracSIS and ObjectStore is not complete 
until the computer has been restarted. The ObjectStore Server 
and Cache Manager services will automatically be restarted 
when the computer is restarted. 
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Licensing your FracSIS software 
  

 
If you have already received your FracSIS license file, 
either for a trial/demo license or for a permanent license, 
you can skip this section. 

 

 
Licenses issued for previous versions of FracSIS are not 
valid for the current version of FracSIS - you will need to 
upgrade your licenses. If you have an earlier version and 
have not yet received a license file, contact Technical 
Support at support@fractaltechnologies.com. 

If you are upgrading from FracSIS 3.x, refer to the 
instructions contained in document FracSIS License 
Installation.html, which is found in the Networked 
License Server\fractal_license_server subfolder of 
your FracSIS 5.x Installation CD. This document covers 
the steps required to upgrade your old license to the new 
license issued for FracSIS 5.x. 

You will need a valid license to operate your FracSIS software. To 
generate such licenses, Technical Support needs to know: 

 The types of licenses you require (stand-alone [node-locked], 
or networked [floating]). 

 The HostID values of the computers where the licenses will be 
used.  

 The maximum borrowed period required (for network licsenses 
only). 

Once you have emailed your HostID to Fractal Technologies 
Technical Support, you will get a reply email with your license file. 

FracSIS licenses are either deployed as stand-alone licenses or as 
a 'floating pool' of licenses on a networked License server or 
computer.   

FracSIS licenses: Stand-alone environment 

In a stand-alone installation, your FracSIS license will ALWAYS be 
locked to a particular computer; that is, the license will only 
function on that computer. To generate the license, Technical 
Support needs to know the HostID of the computer where FracSIS 
is installed. For more information, see Finding the HostID of the 
computer (page 16). 
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FracSIS licenses: Network environment 

In the networked environment, a License Server process is set up 
on a nominated License Server computer. This process monitors a 
pool of purchased licenses. Any number of FracSIS clients can 
use licenses from the pool, up to the maximum number of 
available licenses. For example, if your organisation has 
purchased 10 FracSIS licenses and you have FracSIS installed on 
25 client computers, only 10 of those client computers can run 
FracSIS simultaneously. When a user stops running FracSIS, their 
license is released back into the pool for use by another client 
computer.  

To generate the licenses, Technical Support needs to know: 

 The HostID and hostname of the nominated License Server 
computer.  

 The maximum borrowed period required. 

Trial license 

If you require a trial license, you do not need to supply Technical 
Support with any details of the computers where the licenses will 
be used. 

 
 

Finding the HostID of the computer 

On Windows platforms, the HostID is taken as the MAC (Media 
Access Control) Address of the network card (also known as the 
Ethernet Address).  

There are three ways you can get this HostID - Methods 1 and 3 
are only available after you have installed FracSIS; Method 2 can 
be used before you install FracSIS. 

Once you have emailed your HostID and other required license 
details (page 15) to Fractal Technologies Technical Support, you 
will get a reply email with your license file. 

Method 1 (RECOMMENDED) 

This is the most accurate method of getting the HostID, so we 
recommend that you use this method EXCEPT where you have a 
data server that won't have FracSIS installed on it (use Method 2).  

FracSIS must be installed on the computer to use this method. If 
FracSIS is not yet installed, use Method 2. 
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1 From the Start menu, select All Programs > Fractal 
Technologies > Tools > FLEXlm Host ID. A command 
window is displayed with the following: 
lmhostid - Copyright (C) 1989-2002 Globetrotter Software, 
Inc. 
The FLEXlm host ID of this machine is "xxxxxxxxxxxx" 
The FLEXlm host ID of this machine has been written to 
C:\lmhostid.txt 
Please email C:\lmhostid.txt to Technical Support 
Press any key to continue . . . 

The text represented by xxxxxxxxxxxx is your FLEXlm Host 
ID. This text has been added to a new file (lmhostid.txt) located 
in the root at C: drive of the computer.  

2 Press ENTER to close the command window. 

3 Find the file (at C:\lmhostid.txt), and attach it to a new email. 

4 Send the email with the attached file to Fractal Technologies 
Technical Support at support@fractaltechnologies.com. 

Method 2 

Use this method if you haven't installed FracSIS yet, or you won't 
be installing it on this computer (as is the case with a data server). 

1 Open a Command window (from the Start menu, select Run, 
type cmd, then press ENTER). 

2 Type ipconfig /all>c:\hostid.txt  

3 Press ENTER, then type exit to close the Command window. 

4 Go to the C: drive and locate the hostid.txt file just created. 

5 Right-click on it, then select Send To > Mail Recipient. 
6 When your email application opens, send an email with the 

attached hostid.txt file to Technical Support at 
support@fractaltechnologies.com. 

Method 3 

FracSIS must be installed on the computer to use this method. If 
FracSIS is not yet installed, either: 

 Use Method 2 
- OR - 

 Copy the lmtools.exe file from the installation CD (under 
Networked License Server\fractal_license_server) to the 
local C: drive, then run it. 
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1 From the Start menu, select All Programs > Fractal 
Technologies > Tools > Licensing Tool. The LM tools 
window is displayed. 

 
2 Click the System Settings tab.  

 
3 The Ethernet Address field contains your FLEXlm Host ID. 

Copy the value in this field. 

4 Open a new email, then paste the value into it. 

5 Send the email to Technical Support at 
support@fractaltechnologies.com. 

 
 

Installing a stand-alone license 

Once you have emailed your HostID and any other relevant details 
to Fractal Technologies Technical Support, you will get a reply 
email with your license file. 

1 Save the license file from Technical Support to a directory on 
your hard disk. We suggest you save it to C:\Fractal Licenses. 

2 The first time you start a FracSIS application, you will be 
prompted by the FLEXlm License Finder to specify the location 
of your license. Select the Specify the License File option, 
then click Next.  
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3 Browse to the license file you saved to your hard disk in step 1, 
and select it. 

4 FracSIS will start - you will not have to specify the location of 
the license file again. 

  

 
If the FLEXlm License Finder does not open, a previous 
version of FracSIS may be installed on your machine. 
You can force FracSIS to allow you to respecify the 
license location by running the Clear License tool 
supplied with FracSIS. To do this, shut down any open 
FracSIS windows, select Start > All Programs > Fractal 
Technologies > Tools > Clear License, then restart 
FracSIS. 

 
 

Installing a 'floating pool' of licenses 
1 Once you have emailed your HostID and any other relevant 

details to Fractal Technologies Technical Support, you will get 
a reply email with your license file. 

2 Follow the instructions for installing a Floating License Server.  

These instructions are in the FracSIS License Installation.html 
file found in the Networked License 
Server\fractal_license_server subfolder of your FracSIS 5.x 
Installation CD. 

If you have any problems or queries regarding license installation, 
contact Technical Support at support@fractaltechnologies.com. 
 

Fractal dongles 

A Fractal dongle is a small USB hardware device that connects to 
a computer and acts as an authentication key for a particular piece 
of software. When the dongle is present, the FracSIS software will 
run properly; when it is not, FracSIS won't run. Fractal dongles 
work in conjunction with FLEXlm licenses. 

Several computers can have FracSIS installed and share the one 
dongle. This means that only one computer can have FracSIS 
running at any one time. To run FracSIS on another computer, 
remove the dongle from the first and connect it to the second 
computer. All computers that are to use the dongle must have the 
drivers and license key installed on them, as well as the FracSIS 
software.  
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Best practises 

Dongles are valuable objects. We recommend that you insure 
them for the full replacement value of the software they enable. 

Replacement 

We will only replace a dongle if it malfunctions. (Loss or damage is 
your responsibility; we suggest you insure against such events.) 

A malfunctioning dongle must be returned to us. We will test it, and 
if we confirm that it is faulty, we will replace it at no cost to you. We 
will issue you a temporary license until you receive your 
replacement. 

If no malfunction is found, you will be charged a fee that covers 
administration, testing, and shipping and handling, and the cost of 
a new dongle (if required). 

 
 

Installing a dongle 

Requirements 

For each computer that is to use the dongle: 

 FracSIS must be installed 
 The usbkey.exe file must be available 
 The FracSIS license file for the dongle must be available (you 

get this from support@fractaltechnologies.com) 
 

Step 1. Install the drivers 
1 Double-click on the usbkey.exe file to run it. 

2 The first stage unpacks the file. Click OK on the success 
message. 

3 The second stage installs the drivers required to run the 
dongle. This takes about a minute. 

4 Click OK on the final success message (the message with 
"Aladdin" in the title bar). 

 

Step 2. Insert the dongle 
 Insert the dongle into an available USB port on the computer.  

The dongle must remain in this port for FracSIS to work. As 
soon as it is removed, FracSIS will stop running. 
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Step 3. Install the license file 
1 Copy the license file from Fractal Technologies Support to the 

computer. Suggestion: C:\Fractal License. 

2 Run FracSIS. The splash screen displays, then you get a 
message about selecting a license. 

3 Choose the Select a License File option, then click Browse. 

4 Navigate to where you installed the license file, select it, then 
click Open. 

5 Click OK on the message that displays when the license file is 
successfully installed. 

6 FracSIS will now start. 

 

Repeat the above steps for any other computer that is to share this 
dongle. 
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Upgrading your database from v3.x or v4.x 
  

 
FracSIS 3.x and 4.x databases must be upgraded to 
version 5.x before FracSIS 5.x applications can open 
them. 

WE RECOMMEND THAT YOU BACK UP YOUR 
DATABASES BEFORE UPGRADING THEM TO 
FracSIS 5.x. 

When you open a FracSIS 3.x or 4.x database using FracSIS 5.x, 
you are prompted to upgrade the database: 

 If you have already backed up this database, click Yes to 
upgrade the database to FracSIS 5.x.  

 If not, click No to cancel the upgrade, then contact your 
FracSIS Administrator or System Administrator to make sure 
that the backup has been scheduled.  
Once the backup is completed, open the earlier database and 
click Yes to upgrade it. 

  

 
Once FracSIS databases have been upgraded to version 
5.x, you cannot open them using older versions of 
FracSIS. For this reason, we recommend that all users in 
your group or organisation upgrade to FracSIS 5.x at the 
same time. 
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Troubleshooting installation issues 
 

Problem Solution 

I get an "Unable to 
locate DLL" message 
when I try to open 
FracSIS like: "The 
dynamic link library 
O6CLIEN1.dll could not 
be found...." 

You have installed FracSIS but have 
either not installed ObjectStore, or have 
not installed it correctly. Follow the 
ObjectStore installation instructions very 
carefully - do not blindly follow the 
installation wizard. You may need to 
uninstall ObjectStore and FracSIS and 
start again. 

I get a "Database 
Connect Error" message 
(see below) when I try to 
run FracSIS from the 
workstation and create a 
new database. I checked 
that the service is 
running on the server, 
and it appears to be OK. 

The message indicates that there is no 
Database Server running on the <name 
of server> machine.  
 Check that ObjectStore is installed 

on this machine. If it is not installed, 
install it. 

 If ObjectStore is installed, the Server 
log file may not have been initialised 
during the installation process. If this 
was not done, the server won't start. 
The only solution is to reinstall 
ObjectStore, selecting the Set Up 
Server option and making sure that 
you select Yes to reinitialise the log 
file during the installation process. 
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